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PeopleSoft stores and processes large amounts of data related to UVM, its people, and its finances.
Users are able to employ that data in practical ways by running Reports, Queries, and Inquiries. This
document provides information about what the PeopleSoft database has to offer and instructions
to make accessing data easy.

Reports

There are two types of reports in PeopleSoft: delivered and custom. Delivered reports are those
that designed by Oracle/PeopleSoft developers and come as a standard part of the package. You
will find delivered reports throughout the database under various menu items. Custom reports are
those written and designed by UVM employees with the University’s unique needs in mind. These
reports are more personalized and can be found under the UVM Reports menu heading.

Run Control ID Setup for PeopleSoft Reports

e Run Control IDs are placeholders for sets of values within a report.

e Run Control IDs need to be created in order to run reports in PeopleSoft. Once this series of
steps is completed, run reports as often as needed with this Run Control ID without redoing
these setup steps.

e Most people need only one or two Run Control IDs. However, when managing a series of
projects or chartstrings, and consistently running a series of reports with similar criteria for
each project or chartstring, consider creating a Run Control ID for each project.

e The criteria in each report can be changed as often as needed without entering a new Run
Control ID.

e Run Control IDs can be deleted by navigating to: UVM System > Delete Run Control IDs

How to Set Up a Run Control ID

1. Login to PeopleSoft through either the Human Resources or Financials login.

2. Navigate to a report to run. The Run Control ID screen will appear with the name of the report
chosen to run at the top of the screen.

3. If a Run Control ID has already been created, type it into the search box and click Search. Then
skip to Step 6.
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Meonthly Budget Rpt - Projects

Enter any information you have and click Search. Leave fields blank for a list of all values.

[ Find an Existing Value II Add a New Value

Search Criteria

Run Gontrol ID[ begins with v ||

[Jcase Sensitive

Search Clear

Basic Search @3 Save Search Criteria

4.

If a new Run Control ID needs to be created, click the Add a New Value tab. Enter the new Run

Control ID. Choose an ID that is memorable and related to the values used to run the report.

Monthly Budget Rpt - Projects

Find an Existing Value | Add a New Value

Run Control ID

Add 1

5. Click Add.
6. The report screen will appear.

Projects Monthly Budget Report

Run Control ID Budget_Report
Language English w

Required Parameters

Report Manager

“Fiscal Year| 2020) +*period From 1/CQ, July

Qutput Options

[ Transaction Detail in XLS [ Transaction Detail in PDF

[ Financial Data in XLS [ include Payroll Detail

End Date Between

Bl
] Non-Sponsored at Detail Level? Oinclude PO Summary and E‘:I
Projects Personalize | Find | (2] First (4) 10f1 (k) Last
Project Description Include Net Assets
1037287 | Howe West Stairwell 0O [+ =

to  *Period To | 12/CQ June

M include Closed Projects?

Monthly Budget Rpt - Projects

Process Monitor jug

7. Enter the report criteria and run the report as appropriate.
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Deleting Run Control IDs

Run Control IDs can be deleted by navigating to: UVM System > Delete Run Control IDs or under

Tools in the UVM Business Mgr WorkCenter.

Y -

Tools

(o -]

Delete Run Control Ids

’Run Control ID ACHS
e

1. Pick Run Control 1D from Dvop

[ Delete Nd
Report Manager 2212t No

4.Click Process Monitor hyperlink above
Query Viewer Down
2. Click the Seve button 5.Confirm process runs to Sucoess.
Process Monitor below
2. Click the Delete Now Button. £.Click details hyperlink & Out file to see work performed.

Report Manager

*User |0 tjbarker

Iu nControllD

lSave

Accounting Tags K

Delete Run Control IDs B
Wy Preferences
User Defaults

External Links

GL & Budget

Purchasing & Accounts Payable

~

Grants & Projects

*Frocess Moniter

72726 - Delete Run Coontrols

Process Monitor

After submitting a job, use Process Monitor to review the status of scheduled or running processes.
View all processes to see the status of any job in the queue and control processes previously

initiated.

The Process Monitor consists of two pages: the Process List page
Process List page to monitor the process requests that have been
encounters an error, or if a server is down, it is noticeable almost
page also shows processes are queued to run in the future.

and the Server List page. Use the
submitted. If a process
immediately. The Process List

1. Login to PeopleSoft through either the Human Resources or Financials login and navigate to

the report you want to run.
2. Once the Run Control ID and associated criteria are entered, and the report has been run, click

the Process Monitor link.

Status Bar
Projects Monthly Budget Report
Run Control ID Budget Report Report Manager Process Monitor
Language Process Instance: 4835475

3. Inthe Process Monitor Process List, click the Refresh button until the Run Status shows

“Success” and the Distribution Status shows “Posted.”
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4. Once the report has run successfully, click the Details link.

Process Monitor

Print New V
| Process List ‘ Server List
View Process Request For /
User D |Hibarker Q Type v Last v 10 | Days v Refresh
Server hd Name Q| Instance From Instance To Report Manager
Run Status v Distribution Status v Save On Refresh
Process List
5 Q 1-140f 14 ~ | View All
Select Instance Seq. Process Type Process Name User Run Date/Time Run Status Ig:::[lils:ulion Derzils/
4835475 SQR Report UVMPMBR tibarker 10/16/2020 1:50:37PM EDT Success Posted | Details
5. On the Process Detail screen, choose View Log/Trace.
Process Detail x
Help
Process
Instance 4835475 Type SQR Report
Name UVMPMBR Description UVM Projects Budget Report
Run Status  Success Distribution Status Posted
Run Update Process
Run Control ID Budget_Report Hold Request
Location Server Queue Request
Cancel Request
Server PSNT
Delete Request
Recurrence Re-send Content Restart Request
Date/Time Actions
Request Created On  10/16/2020 1:50:41PM EDT Parameters Transfer
Run Anytime After 10/16/2020 1:50:37PM EDT Message Log
) Batch Timings
Began Process At 10/16/2020 1:50:52PM EDT
View Log/Trac
Ended Process At 10/16/2020 1:51:17PM EDT \

6. To retrieve the report, click on the appropriate link on the View Log/Trace screen.

File Name Descriptions:

PDF: Portable Document Format, an image or snapshot
CSV: Comma-Separated Values, can be manipulated via Excel or other spreadsheet software
XLS: Microsoft Excel, originated and saved in Excel
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View Log/Trace X
Help
Report
ReportID 4459920 Process Instance 4835475

Name UVMPMBR Process Type SQR Report

Run Status Success

UVM Projects Budget Report

Distribution Details

Distribution Node PSXREP2 Expiration Date  01/14/2021
File List
Name File Size (bytes) Datetime Created
ACTUALS_DTL_UVMPMBR_4835475.csv 9514 10/16/2020 1:51:17.681520PM EDT
SQR_UVMPMBR_4835475 log 1,758 10/16/2020 1:51:17.681520PM EDT
UVMPMBR_4835475 PDF 12,207 10/16/2020 1:51:17.681520P EDT
UVMPMBR_4835475.out 0 10/16/2020 1:51:17.681520PM EDT

7. To go back to the Process Detail screen, click Return.
8. To go back to the Process List page, click OK.
9. Click the report title link at the bottom of the page to go back to where task started.

Send Reports via Email

PeopleSoft provides flexible ways to access and share information. The email function allows users
to forward reports directly to individuals and groups without having to shuffle between several
different software programs.

These instructions apply to emailing reports from both HCM and FSCM.

1. Set up the parameters and chartfields for a Financials or HR report that uses the Process
Monitor.
2. Click Run.
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3. The Process Scheduler Request screen will appear. Select Email from the Type dropdown, and
then click Distribution.

Process Scheduler Request X
Help
UserID  tjbarker Run Control ID  Budget_Detail
Server Name | PSNT - Run Date | 10/16/2020
Recurrence v Run Time | 1:56:45PM Reset to Current Date/Time
Time Zone Q
Process List
Select  Description Process Name Process Type “Type “Format Dislribution/
Budget Transaction Detail Rep GLS8005 SQR Repeort ; PDF - Distributiof
Email
File
Printer
OK C |
‘. b Web
Window
»

4. On the Distribution Detail page, enter an Email Subject and Message Text. Enter email
addresses separated by semi-colons, as shown in the Email Address List field. Click OK. (Please
note, each time this Run Control ID is used, the email settings will be used.)

Distribution Detail x

Help
Process Name GLS8005
Process Type SQR Report

Folder Name -

Retention Days 90

Email Only

Email Subject Email With Log: [ Email Web Report:
Budget Report

Message Text

Attached is the budget report for your review

Email Address List
netid@uvm edu: rally cat@uvm edu|

Distribute To
“ID Type Distribution ID

User ~  |fbarker Q, + -

| OK Cancel

5. On the Process Scheduler Request page, click the OK button.
6. When the report runs, the output will be emailed as a PDF file to the individuals specified.
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PeopleSoft Queries are an alternative to running reports. All queries have been written by UVM
employees and are designed with UVM’s needs in mind.

An advantage to accessing information through queries is the option to send them to Microsoft
Excel, which makes manipulating the data easier and more user friendly. For a list of available
gueries, see Available Reports and Queries (PDF).

1. Login to PeopleSoft through either the Human Resources or the Financials login.
2. In Human Resources, click the UVM Reports and Queries tile. In Financials, click UVM Business
Mgr WorkCenter tile.

Note: Both of these tiles open the Query Viewer by default. You can also click the Arrow III
icon next to the Queries menu to view groups of frequently used queries.
UVM Reports and Queries UVM Business Mgr WorkCenter

3. Enter the desired query into the search field and click Search.

Print

Query Viewer

Enter any information you have and click Search. Leave fields blank for a list of all values.

&
Search By Query Name v begins with

4. The chosen query will show in a list below the search page. Click the appropriate link to run the
report in either HTML or Excel. (Running a report in Excel will allow sorting and rearranging of
results.) If you want to run particular queries on a regular basis, you can add them to a list of
favorites by clicking on the link to the right of the query. Favorites will appear on the screen
each time the Query Viewer page is accessed.
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Search Results

*Folder View | —All Folders — v

uery
H Q 1300f71 v » M| ViewAl

Runto Runto Runto Add to

Query Name Description Owner  Folder HTML Excel XML D it EErories
UV_ACTLS_DTL_ACCTS_RCV non-spensored activity - 11001 Public XML Schedule Lookup References
UV_ACTUALS_DTL_FOR_CHARTSTRING Detail of Actuals Exp For C/S Public HTML  Excel | XML Schedule Lookup References Favorite
UV_ACTUALS_DTL_FOR_NVISION UV_ACTUALS_DTL_FOR_NVISION Public HTML  Excel | XML Schedule Lookup References Favorite
UV_ACTUALS_DTL_FOR_PROJECT Detail of Actuals Exp For Proj Public HTML  Excel | XML Schedule Lookup References Favorite
UV_ALL_NON_WTHD_VCHRS All Non-Withhld AP vchrs Public HTML | Excel | XML Schedule Lookup References Favorite

5. The report parameters will appear. (NOTE: The information entered here will vary based on the
particular query chosen. Additional information on specific queries can be found in the list of
queries at the end of this guide.) Fill in the blanks with the specific information requested and
click View Results.

UV_AP_EXPENSES - Voucher Accounting Lines

From Acctg Dt [#]
To Acctg Dt [E]
Vndr ShortMame Like(%)
Account Like{%) &'}
Dept Like(%) &
Fund Like{%) &

PC Bus Unit Like(%)

View Results ?

6. Results will open in the requested format.

In addition to running reports and queries, PeopleSoft Financials users can access data using
Inquiries. Inquiries are designed to view on screen and they do not transfer well to Excel.

How to Enter a Ledger Inquiry

The first time entering the Ledger Inquiry, an Inquiry Name will need to be created. Existing Ledger
Inquiries can be found by using the Find Existing Value tab.

1. Login to PeopleSoft Financials

2. On the UVM Employee Homepage click on the UVM Business Mgr WorkCenter tile.
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UVM Business Mgr WorkCenter

i

A
sl

3. Click the Arrow III icon to expand the Links and GL & Budget to expand the menu, showing a
list of frequently used links. Select GL — Ledger Inquiry

4. In orderto run an Inquiry, there needs to be an Inquiry Name.

a. If an Inquiry Name already exists, click the Find an Existing Value tab, then click Search. A
list of available inquiries will be displayed. Click the desired Ledger Inquiry to run.

b. To create a new Inquiry Name, select the Add a New Value tab and enter a name for the
inquiry. Click Add.

co
. I’ Ledger

Enter any infermation you have and click Search. Leave fields blank for a list of all values

Tools »
External Links . ‘ Find an Existing Value ‘ Add a New Value
GL & Budget earch Criteria

Create/Update Journal Entries Inquiry Name | begins with |+ “

UVM PurCard Reallocations
Enter Budget Transfer ;
Clear | BasicSearch & Save Search Criteria

Enter Budget Journals

Budgets Overvisw

ind an Existing Value | Adda New Value
Journal Inquiry
GL - Ledger Inguiry

GL - Ledaer Period Comparison

5. The Ledger Inquiry page will open. Complete the fields as appropriate, and then click Search to
retrieve the data.

Ledger Inquiry

Print New Win|

Ledger Inquiry
Enter ledger, period, ChartField and rest of the criteria. Click on Search button to execute the query.
Ledger Criteria

Inquiry Name *Unit *Ledger *Fiscal Year “From Period *To Period Currency

JOURNALS UVMO1 Q@ ACTUALS Q | 018Q 1Q 12Q Q

Stat Code Date Code View
Q Q
Show YTD Balance Include Closing Adjustments Max Ledger Rows
m O Show Transaction Details [ Only in Base Currency 100
Search Clear Delete
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e C(lick Delete to delete this Inquiry.
e C(lick Clear to clear all values and set up the parameters again.

e The parameters associated with a particular Inquiry ID can be changed and resaved it as
often as needed.

6. The data will be displayed on the Ledger Summary page.

e Click the Activity or Detail links to drill into more information about these transactions. All
transactions appearing here are journal entries. (They may have originated as journal
entries or, been generated by another PeopleSoft module like Accounts Payable.) Data in
this search are updated once the journals are posted.

e There may be data not currently displayed on the page. To see it, click on View All (on the
right side of the blue bar, next to the Find link).

e Click the Inquiry Criteria link to return to the search parameters.

Ledger Summary ® & w

Print | New Window | Help | Personalize Page
Ledger Inquiry
Ledger Summary

Before clicking on Detail hyper link, you can click on "Ledger Detail Drill-Down Chartfield Display” to display the chartfields that are pertinent to your
inquiry.

» Ledger Criteria

Go To

Ledger Detal Drill Down Chartfield Display

ial
Ledger Summary Q 1of1 v View All

Ledger Amount by Currency
5 Q 114014 v

m YTD Period

Period Balance ] Period Balance
Period Activity Detail Dept Fund Source Program (in Transacti in B, o c“jfency
urrency)

alance (in
Transaction

ransaction
Currency) Correney)

30650 150 130071 0224 183,255.50 183,255.50 USD 183,255.50 183,255.50 USD

2| Activity Detail 30650 150 130071 0224 1,115,434.19 129868969 USD 1,115,434.19 1,298,689.69 USD

3 Activity Detail 30850 150 130071 0224 -605,947 62 692,742.07 USD -605.947 62 692,742 07 USD

Download Data from PeopleSoft Grids to Excel

&

Use the Grid Action icon at the top of any PeopleSoft grid to download the data contained
within the grid to an Excel spreadsheet. When using this feature, some of the numeric data (i.e.
budgets or expenses) download as numeric and some download as text/labels (alphas). This is
visible in the Excel sheet because some of the values will be left-justified and some will be right-
justified. Excel won't include any of the labels in its calculations (including subtotals) so the data set
may be complete, but the totals are not accurate.

Below is an example of downloaded data in Excel. Any number justified to the left is actually
formatted as text. Resolution: Install the Excel add-in GridTools.xla. Once installed, it will become
available each time Excel is opened.
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=
@ "d9- 1= ps-lxls [Read-Only] - Microsoft Excel [o 3 s
m Home  Insert  Pagelayout  Formulas  Data  Review | View c@oE =
B % Page Break Preview Formulagar | | ﬂ{ ] ) E35 New Window [ Split m = % =
1E] Custom Views mellt] H Amange Al T Hide 3 =] =0
Normal| Page [ Gridlines [ Headings Zoom 100% Zoomto 5 Switch | Macros
Layout (5 Full Screen Selection | CFHl Freeze Panes = (] Unhide ' 58 Workspace Windows ~
Waorkbook Views Show Zoom Window Macros
A2 - 0 v
A B c | b E F G H -
1 Period | Activity| Detail | Project | Period Balance (in ion Currency) | YTD Period Balance (in ion Currency) | currency | Period Balance (in Base Currency) | ¥TD per
14 12|Activity | Detail 33,361.64 1,137,575.42|UsD 533,361.64
15 999 Detail 0.00 1,137,575.42]UsD 0.00
16 0 Detail | 10070 14,057 .39 14,057.39|USD 14,057.39
17 1|Activity | Detail | 10070 795.19 14,852.58|UsD 795.19
18 2|Activity |Detail | 10070 -11,859.62 2,992.96|USD -11,859.62
19 11]Activity | Detail | 10070[0.00 2,992.95(UsD 0.00
20 12 |Activity | Detail | 10070({0.01 2,992.96[UsD 0.01
21 999 Detail | 10070(0.02 2,992.86|USD 0.02
2 0| Detail | 21430] 898 8.98UsD 898

How to Download the Gridtools Add-In

Open Microsoft Excel 2007 or later.

Click on Add-ins.

In the Add-Ins window, select Browse.
Locate the GridTools.xla file saved to the desktop in
select Yes again.

Gridtools should now appear in the Add-Ins list:
[Addms 2]

NOUVHWNR

Add-Ins available:

[] analysis ToolPak O

[ analysis Taolp.

| Conditional S
[]Euro Currency Tools

[+] ridkools e

How to Use the Gridtools Add-In

1. Select the newly added Add-Ins tab.

Click here to download the Add-in file and save the file to the desktop.
Under the File tab in the Excel window, click Options from the menu.

At the bottom of the window, find Manage: Excel Add-ins. Click Go.

Step 1 and select OK. If necessary,

IEII e 2 - |+ ps-lxls [Read-Only] - Mic
Home Insert Page Layout Formulas Data Review View Add
é Calibri 10 AN = =¢ | General
Ea~
Paste J B 7 U- Sy - év == .
Clipboard Font Alignment MNumber

rosoft Excel

-Ins
<0 .00 Condit)
= Eormatt

2. Highlight the numeric data on the spreadsheet.

3. Click on the down arrow and select the appropriate option for the data.

B =

Home Insert Pa
e T .
GridFix = &2 snaoit B W

Grid to Number

Grid to General

Grid to Text ustom To|
Grid to Currency
A B cC D
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Resources/Help

Help/Footprints

If you have questions about information in this document, or, if after reading it, you cannot find the
information you need, please submit a help desk ticket in Footprints.

Training

e Professional Development & Training Classes

Relevant UVM Departments

e Financial Accounting and Reporting Services

Suggestions? Updates?

Send an email to PS9-1Upgrade@uvm.edu.
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